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− Interfejs programu 
− Tworzenie nowego pliku projektowego 
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− Wyświetlanie projektów 
− Korzystanie z pomocy 
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5.1. INTERFEJS PROGRAMU MICROSTATION 

 
 
Oprogramowanie Microstation V8 XM komunikuje się z użytkownikiem poprzez bardzo 
przejrzysty interfejs; po uruchomieniu programu ikoną „Microstation” automatycznie 
umieszczaną w menu – start oraz na pulpicie Windows, jako pierwsze zgłasza się okno 
Microstation Manager (Rys. 1).  
 
 
Rys. 1. Microstation manager  
1) – lista plików, 2) – przeglądanie zawartości dysku twardero i innych  nosników danych, 3) 
– ikona tworzenia nowego pliku, 4) – wybór rozszerzeń plików, 5) – pole „Workspace” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Jest to swoisty eksplorator plików zapisanych na dysku twardym lub innym nośniku danych 
podłączonych aktualnie do komputera. Najważniejsze dostępne funkcje to: 

− Przeglądanie zawartości dysku twardego (Rys. 1.1-2.) odbywa się w sposób 
analogiczny do Eksploratora Windows, możliwie jest, więc wyświetlanie np. dat 
utworzenia pliku, jego rozmiaru, po prawej stronie mamy możliwość podglądu 
zaznaczonego pliku. 

− Wybór rozszerzenia pliku (Rys. 1.4). Micoratstion domyślnie zapisuje pliki z 
rozszerzeniem.dgn, konwertuje również pliki typu.dxf oraz .dwg. Wygodnym 
rozwiązaniem jest, wybranie w polu „Pliki typu” opcji CAD File, dzięki której 
równocześnie wyświetlone zostaną pliki zapisane w tych trzech najpopularniejszych 
formatach.  

− Tzw. pole Workspace w którym można wprowadzić nazwę użytkownika, nazwę 
projektu jak i zapisać pewne ustawienia pasków narzędziowych – podczas tych 
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ćwiczeń używane będą ustawienia domyślen pola Workspace tak jak to jest pokazane 
na rys. 1.5. 

− New File – Tworzenie nowego pliku. Przycisk New File umieszczony jest raczej 
niestandardowo, przeważnie opcje zakładania nowego pliku znajduja się w lewym 
górnym rogu okna, tu umieszczony został po stronie prawej – ikona białej karteczki, 
takie umiejscowienie wymaga przyzwyczajenia. Wciśnięcie przycisku uruchamia 
procedurę tworzenia nowego pliku. 

 
 

5.2. TWORZENIE NOWEGO PLIKU  
 
 
Zakładanie nowego pliku (Rys. 2.) zaczyna się od okna Microstation Managera gdzie 
wybieramy ikonę        otwierającą okno (NewFile). W kolejnym kroku wybrać należy tzw. 
„plik podkładowy” czyli plik typu seed dzięki któremu, można określić czy projekt będzie 
dwu- lub trójwymiarowy (2D / 3D); plik seed zawiera również informacje na temat jednostek, 
kolorów linii, itp. Zasady tworzenie i modyfikowania plików seed opisano w rozdziale 2. 
Dla nowego pliku nalezy zaproponować nazwę oraz wybrać miejsce na dysku twardym. 
Klikając przycisk „zapisz” plik zapisuje się i jest już widoczny w oknie Microstation 
Managera; klikamy „otwórz” by rozpocząć projektowanie.  
 
 
Rys. 2 – schemat tworzenia nowego pliku .dgn 
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5.3. OBSŁUGA PASKÓW NARZĘDZIOWYCH 
 
 
Proszę otworzyć plik interfejs.dgn (dołączony na CD-R) Na jego przykładzie zapoznamy się z 
interfejsem oprogramowania Microstation V8 XM. 
 
Rys. 3. Interfejs oprogramowania Microstation V8 w wersji XM 
(opis na rysunku) 
 

 
Rysunek 3 ilustruje typowy wygląd interfejsu Microstation w wersji XM, oczywiście istnieje 
możliwość personalizowania układu narzędzi, ale w przypadku, początkowego użytkownika 
może to wprowadzić niepotrzebne zamieszanie.  
 

OPIS MENU I PODSTAWOWYCH PASKÓW NARZĘDZIOWYCH MICROSTATION 
 
1 – Standard (pasek podstawowych operacji) (Rys. 3.1) 
Jest on typowy dla większości aplikacji pracujących w systemie Windows; poniżej opisano 
poszczególne ikony dostępne z tego paska.  
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1. Tworzy nowy plik (pomija okno Microstation Manager) 
2. Otwiera istniejący plik .dgn (uruchamia okno analogiczne do Microstation Managera) 
3. Zapisuje projekt* 
4. Drukowanie – przywołuje okno podglądu oraz ustawień wydruku 
5. Wycina zaznaczony element 
6. Kopiuje zaznaczony element 
7. Wkleja obiekty ze schowka (schowek pojedynczy) 
8. Cofa ostatnia operację  
9. ponawia ostatnią operację 
10. Łączy z internetową biblioteka znaków (celek) firmy Bentley.  
11. Uruchamia pomoc programu  

 
 
 
2 – Attributes (właściwości elementów graficznych) 
Pasek dzięki któremu w szybki sposób można zmieniać styl, grubość, kolor linii; pozwala 
sterować przeźroczystością elementów graficznych oraz ich priorytetem. Zawiera listę warstw 
projektu.  
 
 
 
 
 
 
 

1. Wyświetla aktywną warstwę 
2. Zmiana koloru linii (również zmiana koloru wypełnienia) 
3. Zmiana stylu (wzoru) linii 
4. Zmiana grubości linii 
5. Zmiana przeźroczystości obiektów graficznych (regulacja płynna) 
6. Ustawienie priorytety elementów graficznych (działa podobnie jak funkcja „przesuń 

na wierzch / przesuń pod spód pakietu office) pozwala ustalić, który element ma być 
widoczny w całości a który może być przysłaniany przez inne.  

 
 
 
 
3 – Primary Tool (główne narzędzia do zarządzania projektem) 
 
 
 
 
 
 

                                                 
*  bardzo ważną cechą Microstation V8 jest nieustanne zapisywanie zmian jakie dokonywane są w pliku .dgn Po 
zamknięciu pliku, program nie pyta  czy zapisać zmiany, gdyż zapisuje je na bieżąco. Polecenie „Save” (zapisz) 
w praktyce nie jest używane, można więc uktyć tę ikonę. Opcję automatycznego zapisywania można  jednak 
wyłączyć: menu→workspace→preferences→operation;  wyłączając opcję automatically save. 
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Z poziomu tego paska można przywołać najczęściej wykorzystywane narzędzia do tworzenia 
projektu graficznego.  
 

1. Tworzy modele  
2. Umożliwia podłączenie zewnętrznego pliku w formacie CAD (reference) 
3. Umożliwia podłączenie zbioru rastrowego (obsługuje również format GeoTif) 
4. Zarządza układem warstw 
5. Wyświetla warstwy 
6. Umieszczanie celek (bloków / gotowych rysunków) w projekcie 
7. Wyświetla wszystkie informacje na temat zaznaczonego elementu graficznego, 

umożliwia również zmianę jego parametrów (np. koloru, stylu, priorytetu itp.) 
8. Umożliwia rysowanie linii o zadanym wymiarze i pod zadanym kątem. 
9. Otwiera okno Key-in dzięki któremu tekstową komendą można przywołać każde 

narzędzie Microstation.  
10. Popset – reguluje pracę okienek informujących o aktualnym ustawieniu narzędzia 

rysunkowego 
 
 
 
4 – Task Navigation (pasek z narzędziami do rysowania) 
 
Jest to nowy pasek narzędziowy wprowadzony w wersji XM Microstation. Zawiera on 
praktycznie wszystkie narzędzia, którymi możemy rysować najróżniejsze kształty. Do każdej 
grupy narzędzi przypisana jest litera alfabetu; wybranie jej bezpośrednio z 
klawiatury znacznie usprawnia prace projektanta i redukuje liczbę 
koniecznych kliknięć myszką. Przykładowo, wybierając z klawiatury literę 
„Q” otwiera się paleta narzędzi do linii prostych, multilinii oraz linii 
zaokrąglonych (kolejne narzędzia również wybierane są za pomocą skrótów 
klawiaturowych).  
Poniżej zestawiono oznaczenia literowe przypisane poszczególnym grupom 
narzędzi w pasku TaskNavigation 
 
Q – narzędzia do rysowania linii prostych , wielolinii oraz linii 
zaokrąglonych 
W – narzędzia do rysowania prostokątów i wieloboków 
E – narzędzia do rysowania okręgów, elipsy i łuków 
R – narzędzia do nadawania wypełnień w postaci kreskowania (szraf) 
T – narzędzia do tzw. ”tagów” tj. dodatkowych informacji tekstowych 
dołączonych do pliku projektowego (nie omawiane podczas tego kursu) 
A – narzędzia do umieszczania i modyfikacji tekstu 
S – narzędzia do umieszczania i tworzenia gotowych rysunków (tzw. celki / 
bloki). 
D – narzędzia do pomiaru (np. obwodu, powierzchni) 
F – narzędzia do umieszczania wymiarów w projekcie (wymiarowanie) 
 
O tym jak bogaty jest zestaw narzędzi rysunkowych paska TaskNavigation użytkownik może 
przekonać się rozwijając ikonę Task List, z możliwością wyboru jednego z kilkudziesięciu 
predefiniowanych układów narzędzi do rysowania. Ze względu na ich mnogość a zarazem 
powtarzalność narzędzi w różnych układach, nie ma sensu ich szczegółowe opisywanie. 
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Domyślnie, podczas tego kursu korzystać będziemy z ustawienia Drawning dającego 
najłatwiejszy i najpełniejszy dostęp do wszystkich narzędzi rysunkowych. Z kompozycji 
DrawningComposition korzystać będziemy jedynie w celu użycia narzędzi „S” i „ D” dzięki 
którym łatwo i szybko możemy narysować np. chmury. 
 
 

5.4. URUCHAMIANIE NARZ ĘDZI SKRÓTAMI KLAWIATUROWYMI 
 
Kazde narzędzie rysunkowe Microstation przywołać można za pomocą określonych skrótów 
klawiaturowych, przykładowo wciśniecie litery „q” uruchomi paletę Drawning z której 
można wybierać poszczególne narzędzia za pomocą symboli cyfr np. „1” uruchamia Place 
Smart Line. Zasada ta została przedstawiona na rysunku 4.  
 
Rys. 4 Zasada działania skrótów klawiaturowych 
(opis poniżej) 

 
Wybierając z klawiatury literę „Q” przywoływana jest lista narzędzi do rysowania linii; z tej 
listy wybrać można np narzędzie Place Smart Line poprzez wciśnięcie klawisza „1”. W ten 
sam sposób, operując innymi literami i cyframi, można wybrać każde inne narzędzie. Gdy 
narzędzie jest już włączone, wówczas jego ikona podświetla się na pomarańczowy kolor 
(dotyczy to wszystkich ikon w Microstation XM) oraz pojawia się okno ustawień 
wybranego narzędzia - PopSet. Wprowadzane w nim ustawienia odnoszą się wyłącznie do 
wybranego narzędzia. 
Korzystanie z okna PopSetu również wymaga pewnej wprawy. Na potrzeby naszego kursu 
proponuje się wprowadzenie jednolitego ustawienia: 

− Na pasku PrimaryTools (Rys. 33) znajduje się okrągła ikona 
PopSet, kliknięcie na niej P.M. otwiera okno → Properties. 

− włączyć należy obie dostepne opcje (Auto – 
Position, oraz Allow …),    

− potwierdzić OK. 
− ikonę PopSet pozostawić podświetlona na 

zielono tzn. PopSet jest włączony (klikając na 
ikonę L.M mozna wyłączyć PopSet i wówczas 
jego ikona jest koloru czerwonego).  

 
Po wprowadzeniu takich ustawień, okienko PopSet 
będzie ukazywało się gdy: 

− najedziemy kursorem na ikonę włączonego narzędzia 
− Ctrl+spacja 
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5 – Snap Mode* 
Po pierwszym uruchomieniu Microstation, pasek Snap Mode jest niewidoczny, należy go 
włączyć z menu Settings→Snap→ButtonBar. Jest to pasek narzędzi sterujący snapowaniem. 
Snapowanie to przyciąganie rysowanej linii (obiektu) do istniejących już wektorowych 
obiektów graficznych. Pozwala na wykonywanie precyzyjnych rysunków technicznych, 
gwarantuje dociąganie linii, umożliwia np. rysowanie linii pod kątem prostym, linii 
równoległych, stycznych do okręgu, pozwala na znalezienie środka okręgu, środka odcinka, 
miejsca przecięcia dwóch linii itp. Jest niezbędnym narzędziem w rysunku technicznym. 
Domyślenie włączony jest snap typu KeyPoint, snapujący się do kilku, rozmieszczonych w 
równych odstępach punktów na odcinku. Jeśli chcemy by domyślnie włączony był inny 
sposób snapowania należy to zmienić w menu Setings →DesignFile→zakładka snap. Istnieje 
również możliwość włączenia tzw. MultiSnap dzięki któremu możliwe będzie równoczesna 
snapowanie w kilku trybach.  
Obsługa paska SnapMode jest bardzo intuicyjna. Pierwszą ikoną na pasku (1) Toogle 
AccuSnap należy włączyć możliwość snapowania, kolejnymi przyciskami uruchamia się już 
poszczególne tryby snapowania. Istnieje możliwość trwałego włączenia danego trybu 
snapowania (dwukrotne kliknięcie L.M na ikonkę) lub włączenie danego trybu snapowania 
„na jeden raz” (jednokrotne kliknięcie L.M na ikonkę). W czasie naszego kursu stopniowo 
uczyć będziemy się jak wykorzystywać poszczególne sposoby snapowania.  
 
 
 
 
 
 

1. Włącza i wyłącza możliwość snapowania (Toogle AccuSnap), 
2. snapowanie ciągłe, 
3. snapowanie do kilku punktów na odcinku, liczbę tych punktów można samodzielnie 

definiować. By zdefiniować liczbę punktów KeyPointSnap wystarczy użyć skrótu 
klawiszowego „k” który uruchamia niewielkie okno dialogowe w którym wybiera się 
lub wpisuje liczbę punktów (właściwie jest to liczba odcinków na którą dzielony jest 
odcinek tzn. wpisując wartość „2” otrzymamy 3 punkty na odcinku: początek, środek i 
koniec), 

4. snapowanie do środka odcinka, 
5. snapowanie do środka (znajduje geometryczny środek figury której krawędź zostanie 

wskazana), 
6. snapuje w miejscu przecięcia dwóch lub kilku odcinków, 
7. umożliwia rysowanie stycznych, 
8. umożliwia rysowanie prostopadłych, 
9. umożliwia rysowanie równoległych , 
10. multisnap 1 – pierwsza kombinacja, 
11. multisnap 2 – druga kombinacja, 
12. multisnap 3 – trzecia kombinacja. 

 
 
 

                                                 
* opisane zostały tylko najczęściej używane sposoby snapowania. Dostępne są również inne, rzadziej używane 
tryby; by je aktywować należy kliknąć P.M na pasku SnapMode i wybrać opcję Show All. 

CD-R

ZADANIE

ZADANIE 1 
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6 – View Group (grupy widoków) 

 
 
 
 
 

 
 
Opis poszczególnych ikon paska View Groups: 

1. wyświetla wcześniej oglądany model / grupę widoków 
2. wyświetla kolejny model / grupę widoków 
3. wyświetla listę wszystkich modeli 
4. lista modeli oraz zapisanych grup widoków 
5. Uruchamia menadżera grup widoków (Manage View Groups) 
6. Włącza lub wyłącza jedno z ośmiu okien widokowych. 

 
Pasek View Groups służy do zarządzania widokiem. Jeśli otworzony został plik .dgn 
zawierający projekt (interfejs.dgn) to jego zawartość wyświetlana jest w jednym oknie 
widocznym praktycznie na całym ekranie monitora. Jest to domyślne ustawienie (okno 1 
widoku) lecz nic nie stoi na przeszkodzie aby obejrzeć ten sam rysunek (projekt) w kilku 
różnych widokach (różne powiększenie, inny fragment, a w przypadku 3D również inna 
perspektywa czy kąt). Rys. 5. przedstawia  możliwość wyświetlenia rysunku w kilku 
oknach widokowych, co jest szczególnie przydatne przy bardziej zaawansowanych 
projektach a wręcz niezbędne przy projektowaniu trójwymiarowym. Okna widokowe 
(max 8) można dowolnie ustawiać, odbywa się to za pomocą paska ViewGroup (6) w 
którym można włączyć do ośmiu okien widokowych, oraz paska Dialog / ViewControl  
(7) który zawiera narzędzia do manipulowania widok w obrębie pojedynczego okna 
widokowego (np. przybliżanie, oddalanie, przesuwanie widoku). 

 
Rys. 4. Możliwość wyświetlenia jednego projektu w kilku oddzielnych oknach 
widokowych. 
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Jeżeli już ułożymy okna widokowe w odpowiednim dla nas porządku, to taki układ (układy) 
możemy zapisać tworząc tzw. grupę widoków (ViewGroups). Zapisać można dowolną liczbę 
takich grup widokowych i przywołać każdą z nich w dowolnym momencie pracy nad 
projektem.  

Aby zapisać grupę widoków należy: 
1. ułożyć okna widokowe w żądanym układzie 
2. ikoną „5” uruchamiamy kreatora grup widoków  
3. w kreatorze grup widoków ikoną białych kartek (Create View Groups) tworzona 

jest nowa grupa widoków dla której należy podać nazwę i opcjonalnie krótki 
opis, 

4. rozwijając listę (ikona „4”), bądź bezpośrednio z poziomu kreatora grup 
widoków, można przywoływać zapisane układy okien poprzez kliknięcie L.M na 
nawę wybranej grupy.  

 
Rys. 5 Menadżer grup widoków (Manage View Groups) 
1) – tworzy nową grupę widoków, 2) – umożliwia zmianę nazwy i opisu danej grupy 
widoków, 3) – usuwa wybraną grupę widoków. 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
7 – View ToolBox / ViewControl 
 
 
 
 
 
 
 
 
Ten niewielki pasek wyświetlany jest w lewym górnym rogu każdego okna widokowego; 
jego działanie odnosi się wyłącznie do jednego okna widokowego (każde z okien ma swój 
własny pasek). Jeśli pasek View ToolBox nie jest widoczny, należy go uruchomić z 

CD-R

ZADANIE

ZADANIE 2 
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menu→Window→View ToolBox.* Poszczególne ikony tego paska służą do manipulowania 
widokiem w obrębie tylko jednego okna widokowego.  
Dostępne są następujące opcje: 

1. View Attributes (Rys. 6.) - wyświetla opcje okna widokowego, 
2. Odświeża widok (przydatne przy bardziej złożonych projektach, szczególnie 3D), 
3. Zoom in – przybliża widok; wpisując w okno PopSetu odpowiednia wartość liczbową 

można określić stopień przybliżania, 
4. Zoom out – oddala widok, 
5. Window Area – rysuje prostokąt do którego ograniczony zostanie widok, 
6. FitView  – pokazuje cały rysunek w oknie widokowym. Jeśli zdarza się, że otwieramy 

plik z projektem a w oknie widokowym projekt nie wyświetla się w całości (bądź w 
ogóle) należy użyć właśnie funkcji FitView), 

7. Rotate View – obraca widok, funkcja przydatna w modelowaniu 3D, 
8. PanView – popularnie zwany „łapką” – służy do przesuwania projektu w oknie 

widokowym, można go uruchomić wciskając rolkę myszki, 
9. przywołuje poprzedni widok w oknie widokowym, 
10. przywołuje wcześniejszy widok w oknie widokowym, 
11. kopiuje widoki pomiędzy poszczególnymi oknami widokowymi, 
12. zmiana trybów wyświetlania (używany w modelowaniu 3D do zmiany sposobu 

wyświetlania krawędzi i powierzchni), 
13. ClipVolume – przycina głębię widoku (używany wyłącznie w modelowaniu 3D), 
14. Clip Mask - Przycina maskę widoku (używany wyłącznie w modelowaniu 3D). 

 
Na omawianym pasku View ToolBox jako pierwsza znajduje się ikonka ViewAttributes. Po jej 
wciśnięciu ukazuje się nam okno właściwości widoku (Rys. 6.) 
 
Rys. 6. Okno właściwości widoku (View Attributes) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Z poziomu tego okna można decydować jakiego typu elementy maja być wyświetlane w 
oknie widokowym. Najważniejsze z nich włączone są domyślnie. Podczas naszego kursu 
dodatkowo pojawi się konieczność włączenia: 

                                                 
* może również zdarzyć się, że zamiast narzędzi do manipulowania widokiem w lewym górnym rogu okna 
widokowego wyświetlane są narzędzia do rysowania. Należy wówczas  wyłączyć w  menu 
Window→TaskNavigation in Views.  
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� ACS Triada – wyświetla kierunki osi X,Y 
� Fill  – wyświetla wypełnienia obiektów 
� Level Overrides – umożliwia zarządzanie kolorami w odniesieniu do każdej warstwy 

rysunku 
 
 
 
 
 
 
 
 
 
 
8 – paleta Main 
 
Paleta Main zawiera zestaw narzędzi do pracy na istniejących obiektach graficznych. Z jej 
poziomu uruchomić można narzędzia do zaznaczania elementów graficznych, narzędzia do 
kopiowania, przesuwania, łączenia, rozbijania i wiele wiele innych, wszystkie zostały opisane 
w tym podręczniku. Podobnie jak w przypadku paska Task Navigation, tutaj również 
poszczególnym narzędziom przypisane zostały skróty klawiszowe (cyfry). Wybierając z 
klawiatury np. cyfrę „3” a następnie cyfrę „1”  uruchomimy narzędzie do kopiowania. Poniżej 
zamieszczona zostaje skrócona charakterystyka narzędzi dostępnych z palety Main. 
 
 
1. Element Selection – służy do zaznaczania elementów graficznych (patrz 3.5) 
2. Place Fence – zakłada tzw. „ogrodzenia”; jest to swoisty dla Microstation 

sposób zaznaczania przeważnie kilku elementów graficznych.  
3. Manipulate – zestaw narzędzi do kopiowania, przesuwania, skalowania itp.  
4. View Control – zbiór wszystkich narzędzi których, działania odnosi się do 

okna widokowego; najczęściej używanymi są: PanView tzw. „łapka” oraz 
FitView dopasowujące rysunek do obszaru pulpitu.  

5. Change Attributes – zestaw narzędzi do zmiany właściwości elementów 
graficznych. 

6. Groups – narzędzi do rozbijania, grupowania i rozgrupowywania elementów 
graficznych.  

7. Modify – grupa narzędzi do modyfikacji istniejących już elementów 
graficznych; umożliwia między innymi dodawanie, usuwanie i przesuwanie 
węzłów, usuwanie fragmentów linii itp. 

8. Delete element – pojedyncze narzędzie; usuwa wskazany element.  
 
 
 

5.5. KORZYSTANIE Z POMOCY MICROSTATION 
 
Opisane powyżej narzędzia, należą do podstawowych a zarazem najczęściej używanych 
podczas projektowania. W kolejnych rozdziałach szczegółowo poznawać będziemy zasady 
ich działania, posługując się odpowiednimi przykładami nauczymy się jak wydajnie je 
wykorzystać. Gdyby jednak zaistniała potrzeba pogłębienia wiedzy na temat możliwości 
projektowych za pomocą narzędzi Microstation, zachęcam do skorzystania z funkcji menu 

CD-R

ZADANIE

ZADANIE 3 
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Help → Tracking. Włączenie tej funkcji spowoduje automatyczne otwarcie pliku pomocy za 
każdym razem gdy włączymy jakieś narzędzie. Dzięki temu szybko otrzymujemy pełen opis 
konkretnego narzędzia.  
 
 
 
 
 
 
 
 
 
 
 

CD-R

ZADANIE

ZADANIE 4 


